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The EFI Pro 32r Operations Guide provides an overview of the features and functions of these wide format printers. The 
EFI Pro 32r printers use environmentally-friendly UV-curable inks to ensure higher volume production and improved 
resolution over traditional silkscreen printing.

Operational knowledge of the printer is required. Please refer to these documents:

NOTE:  You must read and understand the following documents prior to operating or servicing this printer.

• http://inkjet.support.efi.com/doc.php?doc=683   - Inkjet Printer Safety Guide
• http://inkjet.support.efi.com/doc.php?doc=4728 - Pro 32r Series Maintenance Guide

Operator training is an essential part of printer installation and operation. EFI Inkjet provides an educational support 
system that assists new and experienced operators to develop and maintain skills. Go to http://inkjet.support.efi.com/
training/ for training information.

Congratulations! You have purchased the finest super wide format digital ink jet printing system in the world. 
EFI VUTEk h Series printers are premium digital ink jet printers with vivid full color printing on a variety of media. 
EFI Inkjet Solutions wants you to get the best possible images from your printer, and wants your printing experience 
to be safe and profitable.

This chapter describes how to safely operate your EFI Inkjet Solutions printer. 

Before operating the printer, personnel must:
• Read and understand the EFI Inkjet Printer Safety Guide, http://inkjet.support.efi.com/doc.php?doc=683, and adhere to all 

safety precautions therein.
• Successfully complete an Operator Training class.

1.0 Introduction

1.1 Before Starting

1.2 Training

1.3 Welcome

1.4 Overview

https://inkjet.support.efi.com/doc.php?doc=4728
http://inkjet.support.efi.com/doc.php?doc=683
http://inkjet.support.efi.com/doc.php?doc=683
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The EFI Inkjet customer support website contains technical supplements, advisory bulletins, operations and maintenance 
guides, software, and Safety Data Sheets (SDS) available at http://inkjet.support.efi.com/index.php. Customers should log 
onto the EFI Inkjet Support site regularly to get current information or advisories affecting their printer or accessories.

1.5 Customer Support Web Site

North & South Americas Europe, Middle East, Africa Asian Pacific (APAC)

Customer Care

U.S 855-EFI-4HLP
(855-334-4457)

+31 20 658 8070 +1 650 357 4790

EuroInk@efi.com

Canada
Mexico
South America

+1 650 357 4790

Technical Support https://inkjet.support.efi.com

US
Canada

855-EFI-4HLP
(855-334-4457)

+32 2 749 94 50 +65 6221 2765

Mexico
South America

+1 412 690 4321 DE +49 2102 745 4500
NL +31 20 658 8080/8069
UK +44 12462 98085

Order Parts

US Customer.Care@efi.com EuroParts@efi.com InternationalOrders@efi.com

Canada
Mexico
South America

InternationalOrders@efi.com
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2.0 Safety 

Operations Guide
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Please read and understand the safety information carefully before operating the printer.

• You must ensure that the PRO 32R PC is never connected to the Internet.
• To avoid any virus contamination, do not connect the PRO 32R PC directly to the Internet and make sure that the IP address 

assigned to the PRO 32R PC is voided on the server.
• Internet connection to the PRO 32R PC will be required ONLY when a remote connection is required by EFI's Service Engineer. 

Once the remote connection is no longer required, it must be canceled.
• Do not install any Antivirus program on the PRO 32R PC, since it consumes between 10 and 20% of the RAM and as a result, 

reduces the printer's performance.
• Do NOT connect any kind of USB memory stick to the PRO 32R PC.
• Non-compliance with the above points may cause malfunction of the PRO 32R PC—which would be the client's responsibility.
• Any damage caused by a virus on the PRO 32R PC is not covered by our warranty and any subsequent service call will be 

charged to the client's account.

2.0 General Safety

2.1 Anti-virus Warning!
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The following safety signs or emergency components are attached to the printer:

2.2 Printer-mounted Safety Labels & Components

Sign/Component Action Action Action

Main Power Switch
Switch printer on/off

Emergency Stop Button Press to immediately to 
halt printer operation.

Emergency Stop Cord

Pull to immediately turn off 
the printer.

Automatic Cutting Device/Surface Label 1:
Do not place hands near 
cutting edges

Label 2:
Keep hands clear

Label 3:
Keep covered when appropriate



Invisible/Visible Radiation
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Label 1:
Do not look directly at 
the UV source

Label 2:
Do not remove guards

Label 3:
Keep the guards closed

Electrical Hazard Label 1:
Electrical Hazard

Label 2:
Do not touch. 
Keep your distance

Label 3:
Disconnect from the main 
supply before touching this 
component or wiring

Hot Surface Label 1:
Hot surface

Label 2:
Do not touch before 
protection is applied

Label 3:
Read the manual regarding 
safe contact

Moving Parts Label 1:
Moving parts

Label 2:
Do no open the guards 
until moving parts stop

Label 3:
Keep hood closed 
during printing

Sign/Component Action Action Action



Danger of Hand Crushing from 
Moving Parts

Safety

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 12

Label 1:
Danger of crushing from 
moving parts

Label 2:
Keep hands clear

Label 3:
Read the manual

Danger of Finger Crushing from 
Moving Parts

Label 1:
Danger of crushing from 
moving parts

Label 2:
Keep hands clear of the 
rollers and shafts while the 
printer is operating

Label 3:
Read the manual

Inhalation of Hazardous Gases Label 1:
Inhalation of hazardous 
gases or vapors

Label 2:
Do not unplug the printer 
or the fan

Label 3:
Ensure that the printer’s 
ventilator is working. Beware of 
the suction.

Danger of Splashing Ink Label 1:
Danger of splashing ink

Label 2:
Keep clear of the area while 
printer is printing

Label 3:
Avoid contact between the ink 
and your eyes.

Wear goggles while working on 
or emptying the 
waste container.

Sign/Component Action Action Action



Watch Your Head
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Label 1:
Watch your head.

Label 2:
Keep clear of moving parts.

Label 3:
Keep the hood closed.

Hidden Cutting Edges Label 1:
Keep hands/fingers out 
of the printer

Label 2:
Keep clear of moving parts

Label 3:
Read the manual.

Pressing Device Label 1:
Keep hands/fingers out 
of the printer.

Label 2:
Keep clear of moving parts

Label 3:
Read the manual.

Danger of Crushing Legs Label 1:
Keep your feet away 
from the printer.

Label 2:
Wear appropriate footwear.

Label 3:
Read the manual.

Sign/Component Action Action Action
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This section lists and describes potentially hazardous items and areas. Care should be exercised when working with or 
near these items and areas.

2.3.1 The Cable Carrier

The cable carrier carries all the cables and pipes between the PC / ink system and the carriage. During printing, the 
carriage moves continuously along the chassis.

2.3.2 The Cover

The cover is located at the front of the printer; its function is to protect user from UV rays and from contact with the 
moving carriage. It opens and closes manually.

2.3 Potential Hazards

Warning:  Contact between the moving carriage and a foreign object can 
cause injury and damage.

Cover - Closed

Figure 2-1  
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• Open the Cover – Pull handle to lift the cover 

• Close the Cover – With one hand, push the lift cylinder as you push 
the cover down with your other hand. 

NOTE:  The printer does not operate unless the cover is closed.

Cover - Open

Figure 2-2  

Lift Cylinder

Figure 2-3  
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2.3.2.1  Safety features

• The soft rubber protectors on the leading edge of the cover minimize injury to hands.

• A safety label on the closed cover instructs the operator to make sure that it is clear of foreign objects.

2.3.3 The Press Roller and Shaft

To minimize the hazards above, mark the floor with wide luminous adhesive tape and create a safety exclusion zone 
of 1m around the printer.

PRESS ROLLER

Do not place your hand near the revolving press roller and shaft. It can get caught and crushed.

As a safety feature, the printer requires that the operator use both hands to press two buttons to activate the 
rollers. A safety label near those buttons instructs users to make sure that the rollers are not obstructed.

Rolling Media Backwards

Rollers can pull and crush fingers on the media if it is manually rolled backwards.

Heed the safety warning labels on the printer's back frame.

To immediately stop the media from moving, press any emergency stop buttons along the printer's rear.
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2.3.4 UV Sources

The printer has two UV sources which operate while printing.
• Looking at the UV light with the naked eye is dangerous. Never look directly at the UV light source.
• When working near active UV lamps, you must wear suitable anti-UV goggles that conform to international standards.
• When printer is idle at home position, the UV shutters are closed; the UV bulbs turn off automatically after 20 minutes idle.
• The printer can print only if the hood is closed.
• The hood is equipped with transparent UV-blocking screens. The UV radiation is contained by the hood and by the opaque PVC 

panels installed along the top edge at the rear side of the printer.
• Before servicing the UV lamps, allow them ample time to cool down. Contact with the hot lamps can burn the skin.

2.3.5 Electrical Hazards

Various printer components are powered by electricity (1-phase 230VAC):
• The PC
• The motor drivers
• The UV bulb assembly
• In addition, within the printer AC voltage is are converted to DC voltages of 5V, 24V and 48V, and distributed to various points. 

Contact with any of these voltages may cause electrical shock and burns.
• Electrical hazard is minimized as follows:

• Circuit breakers: Over-current and over-voltage activate a circuit breaker at the main input and at each AC voltage contact 
point within the printer.

• In case of an overload, the circuit breaker is switches off the printer. The printer’s operator is authorized to open the cabinet 
door to reset a circuit breaker if it triggers. To prevent unauthorized opening of the cabinet, the cabinet door is locked by a 
special key. Only a certified EFI technician is authorized to remove the plastic cover to access the main electricity panel. 
This can be done only after the main power is switched off.

• Safety labels on each electrical cabinet door and near all AC contact points.
• By proper grounding of all electrical circuits.
• By safety labels on each electrical cabinet door or panel.
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2.3.6 Ink System Safety

The ink is heated by printer to its printing temperature. Heater shuts off when the ink reaches the required temperature. 
Before using flushing fluid, make sure that the printer is completely cooled down and powered off.

2.3.7 The Emergency Stops

The Printer is equipped with the following emergency stops:
• Emergency buttons
• Emergency cord
• Laser beam

2.3.7.1  The Emergency Stop Buttons

• The printer is equipped with four emergency stops: front right and left, plus rear right and left.
• Push the Emergency button to immediately stop the printer.
• When pushing the Emergency button, The printer stops, the power is cut off, and the pinch rollers open.
• To activate or reactivate printer, all emergency buttons must be released. To release the emergency button, turn it clockwise.

Figure 2-4  

Emergency Stop Buttons - Front

Emergency Stop Buttons - Rear
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2.3.7.2  The Emergency Cord

Printer is equipped with two emergency cords–front and rear. Pull cord in case of emergency to immediately stop printer

Figure 2-5  

Emergency Stop Cord - Front

Emergency Stop Cord -
Rear

.
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2.3.7.3  The Safety Laser Beam

The safety laser beam is designed to avoid potential hazard from the tension and pinch rollers. Interruption or 
penetration through the laser beam during printing stops the printer.

Figure 2-6  
Laser Source and Mirror - Front

Laser Source and Mirror - Rear
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3.0 Hardware Overview

Operations Guide
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This chapter describes the major assemblies and sub-assemblies of the EFI Pro 32r Wide Format printers, to familiarize 
you with their most important components.

3.1 General Description

3.0 Hardware Overview

Figure 3-1  

Ink & Systems Area Printing Area Operating Area
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Figure 3-2  

Printer’s 
Carriage 
Home 

Position

Printer’s 
Cover

Printer’s 
Monitor

Media 
Output Operator’s Station

Access Printer’s PC
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The following figure shows the rear of the printer. 

NOTE:  The location of Printer parts assumes that the user is facing the Printer, whether at front, back, or sides. 

Figure 3-3  

Air Shaft

Air Shaft Control

Main Switch

Air Outlet
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The Printer comprises a rear set and a front set of the following:
• Air Shaft
• Pinch Roller
• Tension Roller

3.2.1 Air Shaft
• The media is loaded on the rear air shaft and collected on the front air shaft.
• The rubber bladders on the air shaft expand when filled with air in order to hold the loaded media core in place.
• There is a ruler on each end of the air shaft to show the location of the media edge relative to the shaft.

Figure 3-4  

Rubber Bladder Ruler Air Inlet Air Outlet

3.2 Printer Rollers and Shafts
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Each end of the air shaft is inserted into and supported by a chuck.

1. Open the chuck to release or reload the shaft roller, then push the chuck sideways.
2. Close the chuck and put it back into the closed position.

3. Load the media, then fill air into the shaft by inserting the air gun into the air inlet.
4. To release the media, release air by pressing the air outlet (refer to  ) for more details).

Figure 3-5  

Chuck - Open Chuck - Closed
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The ink system includes the main ink containers and ink waste container. These are located at the bottom left side of the 
printer. Each is connected to ink tubes. The connectors, filters, valves and pumps are above the containers. The ink 
system continues to the printer’s carriage, through the secondary ink tanks (SITs), to the print heads. Ink waste goes into 
the Waste ink tray and is collected in the waste ink container.

3.3.1 Ink Containers

    Ink Containers K, C, M, Y

Waste Ink
Container

White Ink
Container

Figure 3-6  

The Pro 32r has six ink tanks, located in the rear right 
cabinet. There are the five print inks (cyan, magenta, 
yellow, black and white) and a waste ink tank (to store ink 
residue collected from the waste tray).

1. Fill each ink tank before it is completely empty.
2. Empty the waste ink container before it is completely full.

The ink level of the five prime ink tanks containers is displayed in 
the GUI. The level of the ink tanks and waste tank are also 
monitored in the FE, on the bottom right side of the control panel. 

The waste tank has a float that alerts (turning from green to red) 
when the collected amount of waste gets too high. Operators must 
monitor this alert, or an overflow will occur.

3.3 Ink Systems

Figure 3-7  
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3.3.2 Ink Pumps and Filters

Figure 3-8  

  Ink Pump 
Connectors

Filter Ink Pump

Two-way 
Solenoid Valve

PP Pump

NP Pump

Filter Solenoid Valve + 
Pump Connector
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3.3.3 Carriage Ink System

Figure 3-9  

Overflow Sensors Air Release Valves Secondary Ink Tanks



Hardware Overview

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 30

3.3.4 Waste Ink Tray

Excess ink from the print heads is collected in the waste ink tray and drained into the waste ink container.

Figure 3-10  
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3.3.5 Ink System and Print Head Configuration

The Print Head configuration:

Figure 3-11  

White Yellow
+ Cyan

Magenta
+ Black

Black + 
Magenta

Cyan + 
Yellow

White
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3.4 Pneumatic System

Figure 3-12  

Air Supply Port Air Pressure Regulators Five-Way Solenoid Valve

Main Back 
Infeed 
Roller

 Front 
Outfeed 
Roller
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3.4.1 Air Pressure Gauges

The pneumatic system is accessible through the right front access door.

Normal pressures:
Main: 4.5 - 5.5 bar (66 – 81 psi)
Back Infeed Roller: 2.5 - 3.2 bar (37 – 47 psi)
Front Outfeed Roller: 2.5 - 3.2 bar (37 – 47 psi)

The following table shows the recommended values for the use of different media types.

NOTE:  Pressure can change when using different types of media.

Media
Infeed/Outfeed Roller 

(bar/psi) Air Shaft (rpm) Tension 
Settings

Vacuum 
Settings Option

Front - Outfeed Rear - Infeed Front Rear

Banner 1.6M 2.8 bar (42 psi) 2.4 bar (35 psi) 20 rpm 25 rpm 30 70

These values are 
approximate. Small 
deviations are OK.

Banner 2.2M 2.4 bar (35 psi) 2.4 bar (35 psi) 20 rpm 25 rpm 30 70

Banner 3.2M 2.8 bar (42 psi) 2.4 bar (34 psi) 20 rpm 25 rpm 30 70

Sticker 1.4M 2.8 bar (42 psi) 2.4 bar (34 psi) 20 rpm 25 rpm 30 90

Multi-roll 
1.4M Vinyl

2.8 bar (42 psi) 2.4 bar (34 psi) 20 rpm 25 rpm 30 90

Multi-roll 
1.4M Vinyl

2.8 bar (42 psi) 2.4 bar (34 psi) 30 rpm 25 rpm 30 90 Do not put air into the air 
shaft. Use roller collars.
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3.4.2 Gun Air Joint



Hardware Overview

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 35

The electric panel is located at the rear left side of the printer.

Figure 3-15  

PLC Driver 
Controller

Y&T Axis X Axis Y Axis 
Motor

Main Power 
Circuit Breaker 
Switch - See 
Figure 3-16

Servo Driver

3.5 Electric/Motion Control Panel



Figure 3-16  

Main Power System 
 DC24V

Servo 
Driver

Lamp
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Caution:  Improper use of the power and electrical connections can endanger 
your life! Do not touch any of electric or electronic components 
without specific permission from an EFI Technician.
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3.6.1 Ink Vacuum Level

The ink vacuum level prevents the ink from dripping through the print head. Apply enough vacuum to prevent the ink 
from dripping through the print heads, but also keep all the nozzles shooting properly. See the pressure table below to 
determine the correct pressure for your jobs.

Adjust ink vacuum level in the FE Preferences Dialog (Vacuum). Pressure is displayed on the carriage and the I/O control.

3.6 Vacuum System

White

CMYK

Figure 3-17  
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Parameter Value Unit

Negative Pressure 
(Color)

-3.8 kPA

Negative Pressure 
(White)

-4.0 kPA

Positive Pressure 
Time (Color)

0.5 Seconds

Positive Pressure 
Time (White)

0.5 Seconds

Main Air Pressure 4.5-6.0 Bars

Negative Pressure 
(Color)

(-)4  ̶  (-)3.3 kPA

Negative Pressure 
(White)

(-)4.5  ̶  (-)3.8 kPA

Figure 3-18  
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3.6.2 Print Table Vacuum System

The print table vacuum motor is located at the bottom right of the printer. 

Figure 3-19  
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The UV LED Curing system comprises two UV LED lamps, one at each side of the carriage.

Main features:
• Low electricity consumption
• Environmentally friendly
• Zero initialization time - immediately ready to work
• Runs at a low temperature, thus enabling printing on a vast range of media types, including heat sensitive media

Figure 3-20  Shown From Side of Carriage

Carriage Ionizer

The ionizer, shown in Figure 3-20 neutralizes the 
electrostatic charge that accumulates, and prevents 
“mist” from accumulating on the media.

Figure 3-20 shows one of the printer’s two ionizers. 
Each ionizer is located adjacent to a LED lamp unit, at 
either end of the carriage.

3.7 UV LED Curing System

3.8 Ionizer (Anti-static Bar)
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The control buttons for the pinch roller, wings, vacuum regulator and lights are located at the front of the workstation.

3.9.1 Vacuum Regulator 

Set the Vacuum level according to media:
• Single or Multi roll printing
• Width (wider media = use lower vacuum)
• Weight (heavier media = use lower vacuum)
• Polyethylene (PE): Work with wings UP

See Air Pressure Gauges for recommended vacuum values.

3.9 Front Control Buttons & Vacuum Knob

Figure 3-21  

1 Open/closes pinch roller 3 Controls vacuum level of the print 
table. See Vacuum Regulator

5 Turns light on print table on/off 

2 Raise/lowers wings 4 Turns backlight on/off 6 Turns on the printer

1 2 3

4 5 6



Figure 3-22  

Display

Control Buttons

Tension Knob
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Controls
• Arrows - Sets the tension
• Rev - Reverse
• Fwd - Forward
• Stop - Stops spinning
• Knob - Sets spinning speed

3.10 Roll Tension Control



Figure 3-23  

Yellow1 + Cyan1 Magenta + Black Yellow2 + Cyan2

White
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There are four purge buttons located at the front left 
of the printer close to the carriage.

The back pinch roller button toggles the roller open / closed.

3.11 Purge Buttons

3.12 Rear Left Control Button

Figure 3-24  
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  4.0 Software Overview

Operations Guide
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4.0 Software Overview

4.1 Front End Window

OK - Saves the settings and closes the dialog.

Cancel/Close - Cancels the settings and closes the dialog.

Apply - Saves the local settings and dialog remains open.

31 2 4 5 6 97 8 10 11

12

14
Figure 4-1  

1 Returns carriage to 
home position.

2 Prints the job. When 
activated, the button 
changes to Pause icon.

3 Stops print immediately. 4 Moves media forward per 
value in Length box.

5 Length Box defines 
distance for media to 
advance/reverse.

6 Moves media backwards 
per value in Length box.

7 Moves carriage to the left. 8 Moves carriage to the right.

9 Initializes the printer. 10 Applies tension to media. 11 Opens Preferences dialog. 12 One Job: Displays main 
screen for one-file printing.

13 Queue: Displays the 
main screen for print 
job queuing.

14 Control Panel: Displays the main screen's control panel 
for defining the printer's settings. See section 4.2 Front-end 
Window - Control Panel.

13
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4.2 Front-end Window - Control Panel

Figure 4-2  Control Panel

3
1

2

4

6

9

7

8

10 11

5
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No. Window Section Unlabeled 
Icons

Icons/Field Description

1 Print Heads Maintenance Step Offset to the Right - For efficient use of the media, you can print several 
Nozzle Test patterns – as many as can fit onto the media.

Nozzle Test When reaching the maximum, a message appears. You can then advance the 
media manually and set the Step Offset to zero, to print the next nozzle test.

Media Adv. After - Advances the Media 120 mm, after the nozzle test print. 
Fire at Home Position 1 Select the duration (0.1/0.5/1 sec)

2 Click the Fire button.
3 Click OK to close the dialog box.

2 Purge Set the duration of the purge (normally 2-5 seconds) for color and white inks.
3 UV System

Opens UV System Settings dialog box. See UV System Settings Dialog for details.

Last Pass Curing Causes carriage to make a pass in both directions to cure any uncured ink take-up. 

NOTE:  Does not print. 

4 Carriage H Motor Move to Position. Set the required Height and choose Apply. 

See Set Carriage Height.

5 Operator Operator’s display. See the User’s Login.
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6 Media List displaying media distances. These include:
• Left - The distance between the left edge of the print table and the left edge of the 

media. When printing multi-roll, the distance between the Left edge of the print 
table and the left edge of each roll is displayed in the group box “Media Status.”

• Width: The width of each of the media rolls being printed.
7 Set/Measure

Opens Media Settings dialog. See Media Settings Dialog for details.

8 Advance Fine Tuning Enables fine tuning the Media Advance feature, in units of 10 microns.

1. Select the print mode from the drop-down menu. 
2. Set the number of Cycles and print the Advance Fine Tuning pattern.

(See Advanced Fine Tuning). 
9 Tension settings Sets the Tension level (Print Tension Power) of the Tension Roller from 0-100%. 

Set tension and click Apply.
10 Quick Settings Setup Enables a quick machine setup for each media. See Quick Settings Setup Feature.
11 Left-Right

Opens Left-Right Calibration window. See Left-Right Calibration Dialog for details.

No. Window Section Unlabeled 
Icons

Icons/Field Description
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4.2.1 UV System Settings Dialog

Figure 4-3  UV System Settings

1

3

4

2

1 Lamps’ Working Hours
The displayed settings are the default values for the new 
imported job, and not those already in the queue.

2 Power Factor
Adjust the power factor, according to the accumulated number 
of hours that the lamps have been used, as required.

3 Balance Test.

Step Offset to the Right - Prints the next nozzle test to the 
right of the previous one, until there is no more room on the 
X-axis. Then prints the next nozzle test on the next line.

4 Resets Printer Counter (Grayed out; unavailable.)

Resets the UV Usage Counter's values defined in the printer 
statistics parameter dialog box. See Printer Statistics.
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4.2.2 Media Settings Dialog

1
2

3

4
5

6

7

8

Figure 4-4  Media Settings

1 Measures distance between the left edge of the print table 
and the left edge of each media roll. Also measures the width 
of the roll(s) in the printer.

2 Specify the required height above the media in the spin box.

3 Number of Rolls identifies the number of rolls to be printed.

4 Media List. 
Left: Distance between the left edge of the print table and 
the left edge of the media. If printing multi-roll, the distance 
between the left edge of the print table and the left edge of 
each roll displays in the Media List box.
Width: The width of each of the media rolls being printed.

5 + Add Roll
- Remove Roll

6 Split media into virtual rolls. Enables you to split the media 
into up to 6 rolls.

7 Remaining Media Length. Settings – Length of Media before 
printing. Prints the remaining Media length.

8 Additional Texts – Add free text to the label. 
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4.2.3 Left-Right Calibration Dialog
This dialog sets the position of heads firing during bi-directional printing, in units of pixels. Opens via the Left-Right icon on the Front-
end window’s Control Panel or from the Calibrations options in the Tools menu.

Figure 4-5  Left-Right Calibration

1 Print Mode – Select the Print Mode to calibrate. 3 Speed - Carriage speed in which you are printing: Slow, Normal, 
Quick, and Fast.

2 Difference – There are four optional carriage 
speeds for each print mode. Speed is predefined in 
the Print Mode list and is usually set to Fast. Make 
sure to insert values in the correct spin box.

4 Set the Step Offset to the Right – Sets the location of the 
pattern on the media width.

5 Test Print – Print the Left-Right Calibration test pattern.

1
2

3

4
5
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4.3 Front-end Window – One Job

1 2

4

5

3

Figure 4-6  Front-end Window - One Job

1 Opens a Job 2 Opens Job Ticket
3 RIP Data Preview. When there is no preview file in the 

mjob folder, the EFI FE creates a preview by calculating 
the four separation files.

4 Job Info. Opens the Select the Job dialog box.
• Size: The size of the job.
• Resolution: The job's resolution.
• Area: The print area.
• Est. Print Time: The estimated print time.

5 Print Settings: 
• Mode - The print mode.
• Speed - The carriage speed.
• Direction - Uni- or bi-directional when printing.
• Alignment - File’s alignment with the media: left, right, or center.
• UV Mode - Which UV lamps are lit: leader, trail, or both lamps.
• Job's Label - Shows if the job's label is set for on or off.
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Figure 4-7 shows the Queue version of the front-end window.

4.4 Front-end Window – Queue

Figure 4-7  Front-end Window - Queue

32 4 5 6

7

 8

11

12

13

 9

1

10
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1 Add job to Job Queue 2 Combine Jobs. Print more than one job simultaneously, on 
more than one roll.

3 Remove job from any pane. 4 Move job up in Job Queue.
5 Move job down in Job Queue. 6 Stops the queue printing after one job.
7 White Pane. Displays the print jobs waiting in the print 

queue. Right-click on a Job to enable the following:
• Open Job Settings 
• Remove Job
• Set the order within the queue. 
• Change Job Status to Hold or Waiting.
• Cancel Job – Drops the Job to the Red Pane

8 Red Pane. Displays the failed/canceled print jobs (i.e. those 
for which printing was not completed).

9 Green Pane. Displays the print jobs that have been 
successfully printed.

10 Media Status. Displays the location and width of the media.

11 Ink Tank Status. Indicates the amount of ink present in 
each of the main ink tanks.

12 When turning on the printer, the SITs begin to heat up to 
the required temperature.

When the Printer Status is orange, it indicates 
that the printer is warming up.

When the system is ready for printing, the
printer status bar turns from orange to green, 
indicating that the required temperatures have 
been reached. The printer status bar indicates 
that the printer is ready.

If the temperature of any of the inks does not reach the 
required level, the status bar remains orange.

Double-click status bar to open Printer Status dialog box.
13 Printer Statuses. 

The printer is not yet initialized.

The printer is ready to work.

The printer is printing.
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Open the View menu from the menu bar on the Front-end window.

4.5 Front-end Window - View Menu

1 Choose One Job Workflow, Queue Workflow, or Control Panel to 
enable which view to display.

2 Opens the I/O Control dialog box. See I/O Control.

3 Opens the Printer Status dialog box. See Printer Status. 

4 Opens the floating tool box. See General Tools.

5 Opens the Print Modes dialog box. See Print Modes.

6 Opens the Printer Statistics Parameters dialog box. See Printer Statistics.

7 Opens the Motion Control - Alarms and Warnings dialog box. See Motion 
Control - Alarms and Warnings.

8 Opens the Phoseon Client dialog box. See UV System Client.

9 Opens the Maintenance Alerts dialog box. See Maintenance Alerts.

3

1

2

4

5
6

7

8

9

Figure 4-8  Front-end Window - View Menu
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4.5.1 I/O Control

The I/O Control dialog box displays the status of the printer’s electronic systems. Screen components that are 
disabled can only be activated by an engineer.

Figure 4-9  I/O Control Dialog Box
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4.5.2 Printer Status

The Printer Status dialog box opens when you double-click the ink tank status in the lower right side of the 
front-end window or from the View menu.

1 Displays the temperature of the ink at the SIT.

Red: The temperature is higher than required.
Orange: The temperature is less than required.
Green: Temperature is in within range.

The actual temperature displays beneath each color.

2 Move the slider to adjust the UV power during printing, if 
needed.

3 Displays the actual amount of UV power used during printing.
4 You can adjust the Image Position from the Printer Status 

dialog box, during printing.

When printing double-sided, you can adjust the horizontal and 
vertical position of the image as well as the tilt.

5 This option is only activated when the printer is printing on 
the back side in double-sided printing.

3

1

2

4

5

Figure 4-10  Printer Status Dialog Box
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4.5.3 General Tools

Some actions on the printer are carried out in dialog boxes that, while open, block access to any other items in the software.

Use the floating tool box to advance media or open/close the hood, even when another dialog box is open.

This tool box floats and therefore, allows access to all the other components of the screen.

1 Advance media 120 mm backwards.

2 Advance media 120 mm forwards.

3 Opens Left/Right Calibration dialog box. See Left-
Right Calibration Dialog.

3

1

2

Figure 4-11  General Tools Floating Tool Box
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4.5.4 Print Modes

The Print Modes dialog box displays the list of print modes that are installed on the printer.

Figure 4-12  Print Modes Dialog Box

4.5.5 Printer Statistics

The Printer Statistics Parameters window shows the usage statistics of the UV LED lamps, for operator’s information only. 
If needed, you can export the printer statistics and send it to an engineer (click EXPORT and save the file).

Figure 4-13  
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4.5.6 Motion Control - Alarms and Warnings

Figure 4-14 shows the Main Control – Alarms And Warnings dialog box. This window is for the information only.

1 Motion Axis No. The motor whose alarms and/or 
warnings are displayed.

2 List of alarms

3 List of warnings.

4 Status: This is displayed when no alarms or 
warnings are shown.

5 Refreshes the window and displays any alarms or 
warnings. If the warnings or alarms persist, shut 
down the printer and restart it.

6 Clear All Alarms and Warnings. Clears the alarms 
and warnings that are displayed.

3

1

2

5

Figure 4-14  Alarms and Warnings Dialog Box

6

4
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4.5.7 UV System Client

The Phoseon Client dialog allows you to view the status of the UV LED. In the Output section, you can find the error log 
if it exists. This window is for the operator’s information only.

Figure 4-15   UV System Client Dialog Box
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4.5.8 Maintenance Alerts

The Maintenance Alerts dialog box appears daily. It displays a list of maintenance tasks that must be carried out at a 
specified frequency. Choose Help for further information.
 

Figure 4-16  Maintenance Alerts Dialog Box
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Figure 4-17  Front-end Window - Tools Menu

1 Switch and manage Operators (See User’s Login section).

2 Opens the Quick Settings sub-menu. See Quick Settings Setup Feature.

3 Expands the Calibrations sub-menu. See Tools Menu - Calibration Sub-menu.

4 Use this feature when creating an ICC Profile for multi-layer print Modes 
(such as C1WC2; CWBWC).

5 Carries out an initialization to the carriage Height motor.

6 Opens the White Ink Stirring dialog box. See White Ink Stirring.

7 Expands the Update sub-menu. See Tools Menu - Update Sub-menu.

8 Opens the Heads Data Mask dialog box. See Heads Data Mask.

9 Opens the Preferences dialog box. See Preferences Dialog Box.

Software Overview
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4.6 Front-end Window - Tools Menu
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4.6.1 Tools Menu - Calibration Sub-menu

4.6.1.1  Drop Velocity - Automatic Left-Right Calibration

Enables automatic change of the Left–Right value when the user changes the carriage height, especially during printing. 
(See Left-Right Calibration Dialog.)

1  The difference between the left and right offset.

2 To run a Test Print.

:
1 Opens Left-Right Calibration dialog. See Left-Right Calibration 

Dialog for details.

2 Opens Automatic Left-Right Calibration dialog. See Drop Velocity 
- Automatic Left-Right Calibration for details.

3 Opens Blockout Sensor Calibration dialog box. See Blockout 
Sensor Calibration for details.

4 Opens Media Position Calibration dialog box. See Media Position 
Calibration for details.

Figure 4-18   Calibration Sub-menu

3

1
2

4

1

2

Figure 4-19  Left-Right Calibration
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4.6.1.2  Blockout Sensor (Optional)

 See section  for details on blockout printing and the use of this dialog box.

Figure 4-20   Blockout Sensor
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4.6.1.3  Media Position Calibration

Before carrying out media position calibration, ensure that the Left / Right settings for slow speed have been calibrated. 
To carry out this calibration, follow the instructions in the Media Position Calibration dialog box.
 

Figure 4-21   Media Position Calibration Dialog Box
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4.6.2 Tools Menu - Devices Initialization Sub-menu

Figure 4-22   Devices Initialization Sub-menu

1

1 Carries out an initialization to the carriage 
Height motor.

4.6.3 White Ink Stirring

Open the White Ink Stirring dialog box via the White Ink Stirring option on the Tools menu. The dialog enables you to 
turn off or on the Main Ink Tank Mixer and Ink System Stirring. When on, these options stir the white ink for 30 seconds. 

Figure 4-23  White Ink Stirring
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4.6.4

Figure 4-24  Update Sub-menu

1

1 Enables you to update the HASP. See HASP Plug.

Tools Menu - Update Sub-menu

4.6.4.1  HASP Plug

The Pro 32r uses a licensed software. You must have a valid license from EFI in order to use the software. The printer’s
features are HASP protected and enabled according to the client’s agreement with EFI. In Figure 4-25 see the dialog box for 
updating the printer’s HASP Plug.
 .

Figure 4-25  Plug Update Dialog Box

31

2

4 5

6

1 Plug Information: 
•  ID: The ID number of the HASP key. 
•  Type: Dongle type
•  Time: The internal HASP key time and date.

2 Shows the expiration date of the license.
3 Options. Indicates available features on your HASP (in green).

This is preset by EFI. When these options have to be changed, EFI 
sends you a new Plug Input Code, by email.

4 Code emailed from EFI.
5 Browse for the Input Code’s location.
6 Updates the HASP dongle with the new data.
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To Update HASP Plug

1. Save the HASP Code .txt file (the attachment from the email) on the GUI desktop.

Figure 4-26  Tools Menu > Update Sub-menu > Plug Option

NOTE:  Make sure you save the HASP code .txt via a RIP station. Do not connect any USB devices to the printer

2. Open the software.

3. From the Tools menu, choose Update > Plug.

4. On the Plug Update dialog box, choose Get Code.
.

Figure 4-27   Get Code



Figure 4-28   Open Selected File
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5. Browse and select the file that you saved.

6. Choose Open.

7. Choose Update.

The updated HASP Plug is activated.

Figure 4-29   Update Input Code
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4.6.5 Heads Data Mask

Open the Heads Data Mask dialog box via the Heads’ Data Mask option on the Tools menu. For engineers isolating print 
issues only, in Engineer mode.

Figure 4-30   Heads Data Mask

1 Select All: Selects all print heads for masking. 2 Selects no print heads for masking. You must then select the 
required print head(s) for masking.

1 2
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4.6.6 Preferences Dialog Box

Open the Preferences dialog box via the Preferences option on the Tools menu.

NOTE:  EFI recommends that you use the metric as system of measurement.

Figure 4-31   Preferences Dialog Box
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1 Units: Various units of measure.

NOTE:  Leave Measurement Units in metric.

2 Remaining Media Length: Enables/disables the remaining 
media length feature

•  Take-up length: The Media length required to reach from 
the Media Roll to the Feeder Shaft.

•  Feed length: The length of Media required to reach from 
the media Roll to the Free-fall Pistons.

3 The three printing modes: Roll-to-Roll, Free-Fall, Flatbed. 4 •  Skip White: When checked, if there is a white section in 
the file (without any data at all), the carriage rests and 
the media advances until it arrives at the next pass 
containing data. Printing then resumes from that point.

•  Add Job Label by default: If checked, the job's label 
with user-set options is printed at the end of each file. If 
unchecked, no label is printed. 

•  Job’s Label Font Size: Determines labels’ font size.
•  Carriage Movement Margin: Distance from the image 

that the carriage will travel on the X-axis before and 
after each pass. Distance can be adjusted on the fly.

•  When printing on media that tend to heat during the 
printing process, this margin gives more time to cool 
down before the next pass.

5 Nozzle Test/Fire All: Set the Nozzle Test’s Print Speed. 6 Wrinkle Detector. Check to activate wrinkle detector .
•  Wrinkle Detect less than: Determine the minimum 

wrinkle height to alert for wrinkles.
•  Wrinkle detection handling: When checked, the printer 

automatically responds to any wrinkles by moving the 
carriage up by a preset value.

7 General options to choose from. 8 Unattended Mode - not in use.
9 All sensors must be activated constantly. 10 Enable/disable End of Media sensors. Alerts when the media 

detaches from the media roll. Must be activated constantly.
11 Job Queue

•  New Job State: Status of new job – Hold/Waiting. 
•  Jobs Gap: The gap between jobs in mm.
•  Add Job to the next available roll when printing multi-roll.
•  Print resume option: If the printer stops for any reason, this 

option enables the resumption of the printing from where 
it stopped. (See Resuming Print)

12 In-line Finishing
•  Slitter Marks length
•  Pause for Slitter Location: Determines the location of the 

slitter mark on the Y-axis. The slitter mark should be 
located between the print table and the T-roller.

(See In-line Finishing (Optional).)



Software Overview

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 74

13 Double-sided Print
•  Head-to-Head/Head-to-Tail Printing Workflow
•  Y Gap before image: Distance between the first printed 

Backlit Registration Marks and the image along the Y-axis.
•  X Gap from image: The distance between the printed 

Backlit Registration Marks and the image along the X-axis.
•  Min X Correction: The minimum correction on the X axis 

at which the printer will correct the misalignment.
•  Min Y Correction: The minimum correction on the Y axis at 

which the printer will correct the misalignment.
•  Swap Front/Back Marks: swaps the side of the media on 

which the marks are printed.
•  Blockout Label to Image: the distance between the 

Blockout label and the printed image
•  Heads to Mark Distance: the distance between the print 

heads and the Backlit Marks.
•  Short Measure: Only measures media location. Carried out 

automatically between copies in Blockout printing.

14 Flatbed Mode
•  There are three options in Flatbed Mode: Manual / 

Autoloader / Vacuum Plate
•  Stroke Mode – Relates to Autoloader only. To 

accommodate long media, the autoloader carries out the 
Stroke procedure, twice (Double Stroke). For regular 
media length Single Stroke is sufficient.

•  Automatic – Back Pistons open and close automatically.
•  Plate size – only relates to the Vacuum Plate and defines 

the size of the installed plate.
•  Automatically raise Back Pistons.
•  Vacuum Plate Auto-Init before print. When enabled, 

the Vacuum Plate INITs before each print.
•  Front Wing to Heads – The distance between the print 

starting point and the media’s edge.
•  Gap before Image – Defines the gap between the edge of 

the media and the print starting point.

15 Automatic White Stirring: Periodically stirs white ink tanks. 16 Connecting the printer to the iPhone server, to enable the 
iPhone application (optional). 
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5.0 Printer Setup

Operations Guide



Printer Setup

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 76

This chapter describes set-up procedures for the EFI Pro 32r Superwide Format Printer. Perform the tasks in this chapter 
when setting up the printer for operation.

The print table on a Pro 32r printer is a uniformly perforated metal beam, leveled with the Y and T shafts. The print table 
supports the media fed through the printer, at the point where the print heads release ink. 

Print tables include a built-in vacuum system and a set two of wings (front and rear) that can be used:
• For mesh and porous media printing, to lift the media above the print table when covered with cloth. (See  section.)
• To set extra tension when printing on challenging media, such as certain kinds of polyethylene.

Figure 5-1  : Print Table
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Print 
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When media passes over the print table, the vacuum reduces wrinkles in the media and ensures stable media advancement.

5.0 Printer Setup

5.1 Print Table



5.2 Printer Carriage 

Figure 5-2  : Open Carriage Cover
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Figure 5-3  : Open Carriage Cover
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5.2.1 Set Carriage Height
Carriage height refers to the distance between the print head plate and the print table. The printer can print on a wide 
variety of media with different thicknesses. The minimum value is 1.8 mm and maximum is 40 mm. 

• To change the carriage height, enter a value in the Height spin box and 
click OK. The carriage height can be adjusted during printing.

NOTE:   The height affects the Left – Right Calibration. In order to keep 
the correct L/R calibration, carry out the Automatic L/R.

5.2.2

Figure 5-5  

Set Wrinkle Detector

When activated, the wrinkle detector alerts when a wrinkle appears on 
the media during printing.

1. To activate this feature, go to Preferences dialog box, and check the 
Wrinkle Detect Less Than check box.

2. Define the minimum wrinkle height to be alerted.
3. Click OK and start printing. When a wrinkle is detected, the printer pauses 

and an error message appears.
4. Click Yes to send the carriage to home position and address the wrinkle. 

Click No to ignore and continue printing.

Figure 5-4  
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5.2.2.1  Addressing Wrinkles

1. Increase carriage height and continue printing. It is not recommended to set the carriage higher than 2 mm.

NOTE:  Calibrate the Auto Left – Right feature when working with the wrinkle detector.

2. Cool down the print table.
3. Increase the movement margin to help the print table prevent from heating up.
4. Open the press roller and adjust the media. Close it and resume printing.
5. Change the print table vacuum level.

NOTE:  When working with media that tend to wrinkle, give it extra stretch by printing with the wings up.
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5.2.3 Crash Protector

The carriage is equipped with two crash protectors—one at each end, as shown. If there is an obstruction along the 
carriage path, the crash protector is triggered and the printer stops working immediately.

Figure 5-6  

Crash Protector Crash Protector Crash Protector

1. When a crash occurs, locate the obstruction and remove it. (If necessary, 
move the carriage manually.)

2. Click OK to continue printing or HELP to access the relevant documentation.

Figure 5-7  
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5.2.4 Initialization Procedure

When performing an initialization, the H(eight) Motor raises to the highest point (factory defined), and then the carriage 

returns to the previous height value.

The printer can print on a vast variety of media with different thicknesses. The H motor enables an accurate carriage 
height adjustment for any media.

It is controlled only by the software and adjusted through:
• The Init procedure
• The H MOTOR group box in the control panel
• The Media Settings dialog box

5.2.4.1  Carriage H(eight) Motor Group Box
Carriage height is displayed at the bottom left corner of the window and can be adjusted using the carriage H motor field 
on the Front-end window. The minimum carriage height is 1.6 mm, and the optimal carriage height is 1.6mm - 2.0mm 
above the media being used, keeping in mind that the lower the gap is set, the greater the chance of carriage strikes. The 
H motor can be adjusted during the printing process.

Figure 5-8  : Carriage H Motor Fields

Carriage Height Display

1. To raise or lower the Carriage H(eight) 
Motor, enter a value in the Height field.

2. Choose Apply.

NOTE:  Do NOT set the Carriage 
height below 1.6mm.

NOTE:   When changing the H motor 
height during printing, the 
Left-Right parameter should 
be changed accordingly. 
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5.2.4.2  Media Settings Dialog Box
The height of the carriage has to be adjusted according to the thickness of the media on which you are printing.

1. Choose the  icon on the front-end window to open the Media Settings dialog.

2. Before measuring, specify the required height above the media in the spin box. 

3. Click the Measure Media icon.  The detector measures the height and adjusts the carriage height. After adjustment, the 

carriage height displays in the Carriage H Motor Group Box.

Figure 5-9  



Printer Setup

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 84

It is crucial to clean the print heads and keep their nozzles clear.

5.3.1 Purge Print Heads
In order to open clogged nozzles, purge some ink through the print heads (using air pressure). The ink is forced through 
the print head and drips onto the ink tray. The purge duration can be controlled through the Duration field in the Front 
End window’s control panel (limited to 5 seconds).

1. In the Duration field, enter the number of seconds you want the purge to take, 5 seconds maximum. The recommended duration 
for everyday use is 2 seconds.

2. Click Apply.

3. Press each of the purge buttons on the left side of the printer 
in order to conduct the purge. 

5.3 Cleaning Print Heads

Figure 5-10  : Select Print Heads

Figure 5-11  
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5.3.2 Wipe Print Heads

NOTE:  See OMM-00166 Pro 32r Maintenance Guide at https://inkjet.support.efi.com/doc.php?doc=4728 for the 
details about wiping print heads.

Figure 5-12  

W              W          Y+C           Y+C         M+B        M+B             B+M        B+M           C+Y         C+Y            W          W

https://inkjet.support.efi.com/doc.php?doc=4728
https://inkjet.support.efi.com/doc.php?doc=4728
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1. Remove any ink that has accumulated on the print heads, using fiber-free wipes (only). When using the wipes, pass them over the 
nozzles once and then use a clean part of the wipe to repeat the process. 

Caution:  Only use fiber-free wipes to clean the nozzles.

Figure 5-13  : Wipe Print HeadsFigure 5-14  Hold Folded Wipe 
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5.3.3 Nozzle Test
Carry out a nozzle test to check that all the nozzles are clear of any obstruction and that the ink is passing through them.

1. Conduct the nozzle test from the Nozzle Test group on the Front-end window’s control panel.
2. In the Step Offset To The Right field, select the required offset for the nozzle test on the media.
3. Choose Print Nozzle Test. The nozzle test is printed. (See samples on following pages.)

Figure 5-15  : Nozzle Test with No Missing Data



Figure 5-16  : Nozzle Test with Missing Data
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4. Carefully examine the entire test. Repeat the purge and wipe.
5. Carry out another test and carefully examine the results, until you are satisfied that all the nozzles are firing.
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5.3.4 Left-Right Calibration Procedure
The printer prints bidirectionally. That is, each carriage pass prints (both right-to-left and left-to-right). 
The two directions must be aligned in order to retain accurate and well-calibrated printing results. 
To do that, you have to perform a left-right calibration test.

1. Choose the Left – Right icon  to open the Left – Right Calibration dialog 

box. (See Left-Right Calibration Dialog for details.) 

Figure 5-17  

2. Select the Print Mode, Step Offset to the Right, and Speed. Then choose the 
Print Pattern button.
• The test pattern includes a fixed scale to represent the number you need to add 

to or subtract from the value in the relevant spin box.
• The ideal calibration is that where the highest concentration of color is in the 

area of '0'. Your aim is to get the most concentrated area of the pattern around 
0, with a tolerance of ±16.

• For example: you are calibrating for 3PassFine Print Mode, in Fast speed.
• If the most concentrated area of the pattern is around -16, subtract 16 from 

the Fast value, and print the Pattern again to see if it moved to the 0 area.
• If the most concentrated area of the pattern is around +32, add 32 from the 

Fast value, and print the Pattern again to see if it moved to the 0 area.



Figure 5-18  : Test Pattern Before and After Calibration

Before Calibration

After Calibration
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NOTE:  Calibration to zero is the goal, but +/-16 is within acceptable tolerance.

3. Repeat this test until you are satisfied with the result.
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5.3.5 Auto Left–Right

The Auto Left-Right feature enables the automatic change of the Left – Right value when changing the carriage height, 
especially during printing and working with the wrinkle detector feature. To calculate the Left – Right value for change 
of height, you have to calibrate the drop velocity. 

NOTE:  Calibrate and activate this feature when working with the wrinkle detection feature (in the General group 
box in the Preferences dialog box).

Calibration is carried out by printing the Left–Right calibration pattern at two heights – 2 mm and 3 mm. The drop velocity is calculated 
from the difference between the two values. Once calculated, the Left-Right calibration is automatically applied at any change of the 
carriage height, of up to 3 mm.

1. To enable this feature, from the Preferences dialog box, check the Auto Left-Right check box, and choose OK.

Figure 5-19  : Auto Left-Right Check Box on Preferences Dialog Box
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2. Choose from Tools > Calibrations > Drop Velocity to open the 
Automatic Left-Right Calibration dialog box.

Figure 5-20  : Automatic Left-Right Calibration Dialog Box

3. Choose the Test Print  button. The carriage automatically 
goes to 2mm height. The Left – Right calibration pattern is printed.

The carriage raises to 3 mm and the pattern is printed again. The carriage 
returns to the height it was at, before you opened the Automatic Left-Right 
Calibration dialog box. The process is displayed in the progress bar.

4. Choose the Stop button  to stop the print process.

5. Adjust the Left–Right values according to the printed patterns.
6. When you choose Save, the drop velocity is calculated and stored for 

each of the four drop settings.
7. From the Control Panel, open the Left-Right Calibration dialog 

box and set the current LR value for fast speed.
8. Choose Update to automatically set the LR values for other speeds.
9. To enable this feature, from the Preferences dialog box, check the 

Auto Left-right check box, then choose OK.

From this point on, the system is able to automatically calculate the LR for a 
change in carriage height.

• The Left–Right values are automatically adjusted according to any change in the carriage height that is less than 3 mm.
• For any change above 3 mm, manually calibrate the LR for Fast speed and choose Update again.
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The Advanced Fine Tuning feature affects the media advance, thus 
preventing gaps or overlaps between the passes in the Y-axis. The aim is 
to maintain no gap or overlap between the passes. The media Advance 
Fine Tuning enables you to slightly open (positive value) and close 
(negative value) the gaps during printing. A change in media tension or 
print table vacuum level affects the media’s advance fine tuning.

Figure 5-21  

1. Load the required media and set the Tension and Print Table Vacuum level.
2. From the Advance Fine Tuning group box in the Control Panel, choose 

the Print Mode you want to fine tune.
3. Set the number of cycles (1 - 10). One cycle prints a test pattern equaling 

the circumference of the Y Roll.

4. Choose Print Pattern  and examine the output. 

5.4 Advanced Fine Tuning
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5. Examine the print and mark the most concentrated pattern area of 
each row, in the middle of the row.

Figure 5-22  : Test Print Example

The print pattern is comprised of several rows, with a fixed scale to represent 
the number you need to add or subtract. Mark the most concentrated pattern 
area for each row and decide on the average number.
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For example: If you print 1 cycle in 3PassFine, and you get the following result:

• You can see the marks of the most concentrated part of the pattern in each row.
• In the second row, you can see that the most concentrated part is between 0 to -4, i.e. -2.
• Find the average value in your marks. In this example it is -2 - -3. 
• Finding that, you should now subtract 3 from the value in the For 3 Pass Modes field, in the Advance Fine Tuning group.

6. Print the pattern again and make further adjustments if required.

NOTE:   During printing, all the pass values are inactive, except for the one being used. You can adjust the fine 
tuning during printing.

Figure 5-23  : Sample Print 1 cycle in 3PassFine
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5.5.1 User’s Login

The user login documents the identity of the user in the Job History log file. This feature serves as a management tool and 
is divided into two sections:

• User
• Manager

5.5.1.1  User: Logging in to the software

1. On the desktop, open the software. The Operator Login dialog box appears.

Figure 5-24  : Operator Login Dialog

Figure 5-25  : Operator Name

2. Select your operator’s name and choose OK.

The name of the current operator is displayed at the top right corner of the Front end window. 

1. To change the operator name, choose Tools > Operators > Switch Operator and log in. 
2. Select the required name from the list and choose OK.

5.5 Other Preparations
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5.5.1.2  Manager: Managing Users and Passwords

The management of users and passwords is carried out through the Operator Manager in the Tools menu. Adding or 
removing users is password protected. To set or change a password, you have to know the old password.

NOTE:  The initial software password is 1234

5.5.1.3  Adding or removing a user

1. Choose Tools > Operator > Operator Manager. 

Add Remove

Figure 5-26  : Operator Manager

2. Enter the Administrator’s password and choose OK.
3. To remove a user, select the user and choose Remove (–). 

4. Choose Yes to remove or No to cancel.
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5.5.1.4  Changing a Password

1.

Figure 5-27  : Operator Manager 

Change Password

Choose Tools > Operator > Operator Manager. 

2. The initial Password is ‘1234’. To change this password, choose Change Password.

Figure 5-28  : Change Password Dialog Box

3. Enter the current Password, enter the new Password and confirm it. Choose OK.
4. Reset password is enabled only in Engineer mode. The reset password button appears in the dialog and choosing it resets the 

password back to ‘1234’.
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5.5.2 Quick Settings Setup Feature

Quick Setup is a 1-stop tool for defining all the settings for a particular media. Each media requires a different set of 
printer settings. Using this feature, you can save the printer settings for each media; thus creating a media list. Each time 
you want to print with media that appears on the list, load it onto the printer, select it from the Quick Settings drop-
down list, and choose Apply.

5.5.2.1  Create/Apply Settings in the Media List

Figure 5-29  : Quick Settings Set Up

Media list

Apply settings

WarningAdd a new 
media

Remove 
media

Edit a media’s 
settings

1. Load the media and step-by-step, set the printer’s parameters:
• Feeder configuration
• Left – Right
• Freefall Continuous Collector (Z)
• Tension
• Carriage Height
• Carriage Movement margin

• Media backward distance
• Freefall Pistons Pressure (Currently disabled in the dialog)
• Press Roller Pressure (S) (Currently disabled)
• Press Roller Pressure (C) (Currently disabled)
• Vacuum (Currently disabled)
• Advance Fine Tuning
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2. After choosing all the required settings, choose the Add button to open the 
Name dialog. 

3. Enter the media’s name and choose OK.

4. Choose OK to save the settings. The media name appears in the Quick Settings drop-down list.
5. To apply quick settings, select the defined media type from the list and choose Apply. The printer is now set up.

Figure 5-30  : Quick Settings Dialog Box

Figure 5-31  : Quick Settings Dialog

List of media types with quick 
setting definitions



Printer Setup

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 101

5.5.2.2 Remove Item from Media List

1. In the Quick Setup group, select the media you wish to remove and choose Remove.

Figure 5-32  : Quick Setup “Remove” Button

The following prompt appears.

2. Choose Yes.

The settings for the selected media are removed.

Figure 5-33  : Deletion Confirmation Prompt
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5.5.2.3  Edit Media Setting

1. In the Quick Setup group, select the media you wish to remove and choose Edit (ellipsis) button.

Figure 5-34  : Quick Setup “Edit” Button

The Quick Settings dialog box appears, showing the settings that belong to the specified media.

2. Make changes in the dialog box or choose Fetch.

The Fetch button sources the current printer settings and replicates them for the media’s settings.

3. Choose OK to save changes.

Figure 5-35  : Quick Settings Dialog Box

Fetch
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5.5.2.4 Warning Symbol

The yellow warning symbol appears when there is a difference between the selected media’s printer settings and the
current printer settings.

Figure 5-36  : Quick Setting Warning Symbol

• If you want to revert to the original settings, choose Apply.
• If you wish to save the current settings of this media, choose Edit. The Quick Settings Setup dialog box appears.
• Choose the Fetch button to replicate the current printer settings, and then choose OK.

5.5.3 Importing/Exporting All Media Settings
1. To export all the stored media settings, choose File > Export > Quick Settings.
2. The software creates a ZIP file named QuickSettingsReport.qs, in the selected directory. (qs is a special extension.) The ZIP file 

contains an XML file for each media type.
3. To import settings to the machine from a .qs file, choose File > Import > Quick Settings.

A prompt appears for each media currently defined on the Printer and prompts you to choose accordingly. Media that are not in the list will 
be added.

4. Choose Yes to replace the existing file, or No to cancel the procedure.

Figure 5-37  : Confirmation Prompt
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  6.0 Printer Operations

Operations Guide
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This chapter covers the process for both standard and backlit printing on the EFI Pro 32r, including defining job settings, 
cropping a job, and multi-roll printing (optional).

Figure 6-1  

Perform all start-up checks and actions every day before printing.

1. Check that the emergency stop buttons are set to “Off.”
2. At the rear left side of the machine, turn the main switch clockwise, to the on position.

3. At the right front of the printer, push the start button. The start button lights up. The 
printer and workstation turn on.

Figure 6-2  

4. Ensure that print table is clear of any foreign objects and any other obstructions.
5. From the workstation computer, double-click the EFI FE icon. The Main Screen appears.
6. Click INIT. The printer’s systems now initialize:

• Carriage Y axis: Carriage activates and rises to its maximum height (factory set). 
• Carriage X axis: Carriage moves along the print table and goes to the Home Position. 
• H Motor Sensor: The Sensor scans the Print Table to measure its highest point.
• In-line finishing: If features are installed, printer prompts you to initialize them.

7. Purge and clean print heads.
8. Run nozzle test.
9. Perform required maintenance procedures as defined in the Maintenance Guide at https:/

/inkjet.support.efi.com/doc.php?doc=4728.

6.0 Printer Operations

6.1 EFI Pro 32r Start Up Procedures
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6.2 Defining Job Settings

1

2

3

4

5

6

7

8

9
10

Figure 6-3  : Job Settings Dialog Box
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1 Job Info Size: The width and length of the Job.
Resolution: Set by default, according to the mode.

2 Print 
Settings

Mode: Set by default, according to the mode. Cannot be changed.
Direction: Single or Bidirectional Printing. Can be changed before you print.
Speed: Available options depend on the Resolution and Mode. Can be changed before you print.
UV Mode: Depending on the direction of the carriage: Leader: the front lamp is lit.
Trail: the rear lamp is lit.
Both: both lamps are lit. This is the default setting. Can be changed before you print.
UV Power – Percentage of the lamp's total power to be used, defined from the UV Power Setting dialog box.
Can be changed before and during printing.
Actual Power – The actual UV power in numbers.

3 Options Noise: Choose from 1-6, only if the print mode allows it.
Double Strike: Doubles the density of the file for backlit printing, only if the print mode allows it.
Scale: To enlarge the Job's size.
Density: To adjust the CMYK density (all, or individual).

4 Double Side Off: One side printing 
Backlit: Backlit printing. 
Blockout: Blockout printing
Back side: to print the back side of double side.
50%: Set the print density to 50%.

5 Positioning Alignment: Aligns the file to the Left, right or center of the media.
Print Offset: Moves the image to the left/right with a set value.
Step & Repeat: Set number of horizontal and vertical copies. Only vertical copies can be changed during 
print. If number of copies results in no gap between copies, there is no gap between newly inserted copies.
Gap: Insert a gap between images. This cannot be changed while printing a Job.
Mirror: Mirror Flip.
Rotate 180: Rotate 180º

6 In-line 
Finishing

Cutter (optional): Activates the X cutter
Top/Bottom: The Job can be cut in its edge (0), in Margins (Negative value) or in Bleed (Positive value)
Slitter Marks: Activate to print Slitter Marks
Along Image: Print marks through the length of the Job.
Left/Right: Locate slitter marks to slit job on its edge (0), in margins (negative value) or in bleed (positive value)

7 Jobs Label Prints any of the following data on the job: File name, Copy #, Time, Mode, manually inserted information.
8 Media Location and width of the media roll(s). 

Edit/Measure: Access to the Edit/Measure dialog box.
9 Roll Number Specify on which of the multi rolls you wish to print the Job.
10 Job State To put the Job on Hold or Waiting to be printed mode.
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The Remaining Media option helps you reduce waste by inserting a signature at the end of a print job, with the following 
data printed on the media:

• Media Type
• Remaining media on the roll
• Date and time

1. Choose Tools > Preferences and check the Remaining Media Length option in the top left corner of the dialog box.

6.3 Remaining Media

Figure 6-4  : Preferences Dialog Box

1 The Take-up Length is the length between 
the front edge of the media and the place 
where it begins to unroll.

2 The Feed Length is the spacing between the end 
of the printing and the end of the media.

1

2
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2. After loading the media, enter the length of the loaded media, in the Media Settings dialog box.

Figure 6-5  : Media Settings Dialog Box
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3. Choose the Settings button. 

Figure 6-6  : Remaining Media Length Dialog Box

4. Enter loaded media length for each roll. Choose OK. If there is insufficient media for the job(s), an appropriate message appears.

Figure 6-8  

The software counts (in the background,) the amount of 
media that has been used. At the end of the job, choose 
Print in the Media Settings window. The signature is 
stamped on the remaining Media.

If you don’t set the remaining media length, a confirm/
cancel prompt appears.

Figure 6-7  : Signature Stamped on Remaining Media
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The following settings can be changed during printing:

Setting Can be changed in …

Nozzle Test
(Fire-all At Home Position)

The Control Panel 
1. Pause the printer. 
2. Purge and wipe the print heads.
3. From the Fire All dialog box, in the At Home Position, choose the Fire button.
4. Choose OK.

Free-Fall Continuous Collec- The Control Panel (If the option is activated.)

Print Tension Power The Control Panel

Advance Fine Tuning The Control Panel

Calibrations The Control Panel

Printer Status The Printer Status dialog box (accessed by double-clicking the printer status bar, to the left of the 
UV Status indicator in the Control Panel).

Increase/Decrease UV Power The Printer Status dialog box

Image Position The Printer Status dialog box (Left – Right, forward – backward).

Step & Repeat (in Y) Specify 
number of copies.

The Job Settings dialog box.
If you have specified a Gap, then it will appear in subsequent copies.

Carriage Movement Margin The Preferences dialog box.

6.4 Changing Settings During Printing
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Using the Print Resume option enables you to resume printing from where it stopped due to a malfunction.
1. In the Preferences dialog box, check the Print Resume option.

When the machine stops, the job is automatically sent to the queue's red pane.

2. Choose the job and drag it back to the green pane. 

3. To resume printing where it stopped, choose Yes.

6.5 Resuming Print

Figure 6-9  : Print Resume Option Check Box

Figure 6-10  : Resume Job Prompt
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4. If you want to start printing the job from the beginning, choose No.

5. If you want to continue with the printing, choose OK.
6. If you wish to make adjustments, do so, and then choose OK.

Figure 6-11  
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The grouping feature enables to print Multi-Jobs and Multi-Layers.

• Click the Grouping button in the Queue View to open the dialog box.

6.6 Grouping

Figure 6-12  
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6.6.1 Multi-Job Printing

1. Name the Group and select the Multi-Jobs Type.

2. Click OK.

The Multi-Jobs Group Settings dialog opens.

3. In the Multi-Jobs Group Settings dialog, click “+” to add a job 
or click “-“ to remove selected jobs.

All the Job Settings apply to all the Jobs in the Queue, except 
for Step & Repeat, Mirror, Rotate180 and the label.

4. To optimize the jobs layout, click the Multi-Job Optimizer icon.

5. Click OK to add the group to the print queue.

6. To reopen the Multi-Jobs Group Settings dialog, double-click 
the group in the print queue.

NOTE:  All jobs in a group must have the same print mode

Figure 6-13  

Figure 6-14  
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Multi-Job 
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.

This section explains how to use the white printing, feature on the Pro 32r printer. It includes the following sections:
• An Overview
• Print methods and applications
• Print procedure for each method

EFI's white ink option enables white ink printing (in addition to color) on various media types and several applications.

6.7.1 White Ink System Overview

The Pro 32r carriage contains 10 print head blocks, two of which are white. The white heads can be aligned with the 
other heads, and can be shifted forwards with the software to enable faster print. The white print heads are located at 
each end of the plate. 

Figure 6-15  

White Yellow
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+ Black

Black + 
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6.7 Printing with White Ink
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The white ink system is independent of the color ink system. It has a separate vacuum generator and the vacuum level for the white SITs 
should be set separately.

The white ink system incorporates additional hardware (separate valve, stirrer, degassers, etc.) to enable stirring the white ink in the main 
tank and in the ink in the tubes. The purpose of stirring is to avoid sedimentation that can cause nozzle clogging.

The stirring of ink in the tank is controlled by the software. 

1. Before printing with white ink, go to Tools > White Ink Stirring. 

2. Select both ON radio buttons to stir the White Ink, and close the dialog. This process takes a few seconds, but you can continue 
working while it takes place.

Figure 6-16  : White Ink Stirring Dialog Box
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6.7.2 White Print Methods and Applications

6.7.2.1  White on Non-White Media

Pure white printing on colored media. This method is primarily used for signage, and for maintaining corporate identity colors.

6.7.2.2  White Under - Color Print On White Layer

Method can be used for printing on non-white media. White opaque layer prints first, allowing colored layer its full gamut.

Figure 6-18  

Color White 
Layer

Red 
Banner

Figure 6-17  
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6.7.2.3  White Over - White Layer Printed On Colored Layer

This method is used for printing on transparent media. The graphic is printed mirror-flipped on the back side of the transparent 
media, as it is viewed from the front. The opaque layer on top of the color enables the colored layer its full gamut.

Figure 6-19  
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6.7.2.4  Backlit – Color-White-Color

With this method, an image is printed on transparent media, with layer of white and additional 50% density layer of color.

Figure 6-20  
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Multilayer printing enables to print two different images on transparent media, in one run. At the end of the process, each
side of the media shows a different image.

Types of Multi-layer:
• Blockout on transparent media - Prints both sides in a single run. The layers are: Color1 -White-Black-White-Color2.

6.8 Multilayer Printing

Figure 6-21  
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• Day-Night on transparent media, Day-Night on backlit media - Prints two different images - one image for front lit or day-
view, the other image for backlit or night view. The layers are: Color1 - White - Color2.

6.8.1 Multi-layer: White / Multi-layer

For this mode you must add a White layer to the image file from within the RIP application. 

1. RIP the file in the relevant Print Mode and add the white layer.
2. Load the relevant media.
3. Make sure all nozzles are firing properly.
4. Calibrate the Left-Right for the relevant Print Mode.

The print workflow of a job with white (White only, White under Color, White Over Color or Color-White-Color) is identical to 
printing a CMYK Job. 

5. Add the job to the Print Queue 
6.  Print.

Figure 6-22  
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6.8.2 Multi-layer: Blockout

In this method the white layer is added to the image file in the RIP application. 
1. RIP the files (C1 and C2) in the relevant Print Mode.

Available printing applications:
• Blockout on Transparent media
• Day-Night on Transparent media
• Day-Night on backlit media

Figure 6-23  

2. Open the Grouping dialog box
 

3. Name the group, and select Multi-layers and Blockout on transparent media
 

4. Click OK. The Multi-layer Group Settings opens. 

5. Click the “+” button to add the files. The Jobs are automatically mirrored and placed 
in the correct order.

6. Set the files and click OK to add the Multi-layer Job to the printing Queue.
7. Print.

Figure 6-24  
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6.8.3 Multi-layer: Day-Night on Transparent Media

Figure 6-25  

1. Open the Grouping dialog box
 

2. Name the group, and select the Type: Multi-layers and Day-Night on 
transparent media

 
3. Click OK. The Multi-layer Group Settings opens. 

4. Click the “+” button to add the files. The Jobs are automatically mirrored 
and placed in the correct order.

Figure 6-26  

5. Set the files and click OK to add the Multi-layer Job to the printing Queue.

6. Print.



Printer Operations

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 125

6.8.4 Multi-layer - Day-Night on Backlit media

Figure 6-27  

1. Open the Grouping dialog box
 

2. Name the group, and select the Type: Multi-layers and Day-Night on 
Backlit media

 
3. Click OK. The Multi-layer Group Settings opens. 

4. Click the “+” button to add the files. The Jobs are automatically mirrored 
and placed in the correct order.

5. Set the files and click OK to add the Multi-layer Job to the printing Queue.

6. Print.

Figure 6-28  
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This chapter describes the media handling accessories and sets out procedures for loading, winding and unwinding options.

Media loading, winding, and unwinding have a great impact on the print results.Proper media handling maintains print 
quality and is key to accurate double-sided printing and overcoming challenging media-feeding issues. Proper media 
handling also helps avoid unwanted print artifacts, which can be caused by media distortion, wrinkles, uneven media 
stretch, tilt and misalignment, etc.

6.9.1 Media Loading and Winding

The printer is equipped with a rear air shaft for media unwinding and a front air shaft for media winding. The air shaft has 
inflatable rubber bladders that when inflated, hold the media steady in place, and the media advance through the printer 
in accordance with the tension rolls and the front air shaft.

6.9.2 Media Path

The media path depends on the media, weather it is printed and collected face-in or face-out.

6.9 Media Handling

Figure 6-29  

Face-In Face-Out
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The media is fed to the printer from the media roll on the rear air shaft, through the pinch roller, above the tension roller, 
over the print table. From the print table, through the front tension roller, over the pinch roller to the air shaft. See Figure 
6-30 for options on the media path.

Figure 6-30  
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6.9.3

Figure 6-31  

Loading Media

1. Load media to the air shaft.

2. Load the air shaft to the printer and close the chuck.

3. Place the media on the X axis. You can use the ruler for fine adjustment.

4. Put the air gun in the air inlet. Pump air to hold media steady in place.

5. Take up the media through the pinch roller. Make sure it is straight and 
parallel to the media roll.

6. Lead the media to the tension roller, over the print table and the front of the tension roller, 
and then between the tension and pinch rollers.

7. Close the pinch roller
.

Figure 6-32  

Figure 6-33  
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6.9.4 Winding or Collecting the Media
1. Load a media core to the front air shaft. The media core must be at least as wide as the media.

2. Load the air shaft to the printer, and then close the chuck.

3. Center the core to the media and lock it in place by pumping air to the air shaft’s air inlet.

4. Close the pinch roller.

5. Advance the media to reach the front air shaft and attach the media’s edge to the core. You can either paste it with paper masking 
tape, or by winding some media.

NOTE:   See Air Pressure Gauges for a table with the media parameters to set before printing.
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6.9.5 Multi-roll Loading

Hardware: 
• Media roll collars 
• Air Shaft Race 
• Center Support Stand 

1. Before setting up center supports, align air cores to table. 

2. Then install the race onto the air core. 

3. Install and adjust the center support stand. 

4. Load media rolls, media roll collars, and air shaft race onto 
the unwind and rewind shafts (air cores). 

5. Secure shaft race to the center of the unwind shaft by 
turning the spanner nut. Hand-tighten ONLY. 

Figure 6-34  

Figure 6-35  
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Figure 6-36  
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6. Center the media rolls and collars between the air shaft race and the 
ends of the unwind and rewind shafts. 

7. Secure media rolls with media roll collars by tightening each collar. 

NOTE:  Do NOT inflate air core for the rewinding shaft. 

Caution:  The fully loaded Unwind Shaft (Air Core) is 
extremely heavy. Care and safe lifting 
procedures should be observed or serious 
injury can result.
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When printing on mesh or other porous media, some measures should be carried out to maintain good print quality and 
to protect the print table from excess ink.

Figure 6-37  

NOTE:   To avoid any damage to the print heads, the carriage must be raised to at least 14mm 
before you start the procedures.

1. Before starting to prepare the printer for mesh printing, 
go to View > I/O Control.

2. In the Misc Sensors group, find the Mesh Table sensor 
display to make sure that the mesh table is working. 
When the wings are raised, the display turns green.

3. Raise the wings of the print table by pushing the button 
marked Wings, on the front control panel.

4. Turn off the vacuum supply with the vacuum regulator.

6.10 Printing on Mesh

Figure 6-38  



Printer Operations

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 133

5. Place the absorbent cloth along the print table, between the wings.

6. Attach both edges of the cloth to the table frame, using Scotch Tape.

7. Make sure the cloth edges are totally covered with tape and properly attached.

The printer is now ready to print on mesh media.

8. To return to another printing mode, lower the wings by pushing the Wings button again on the front control panel and removing 
the absorbent cloth.

9. If necessary, clean the print table from any ink residue.

6.10.0.1 

Tension 40

Front air shaft (winding) 22 Uninflated

Rear air shaft (unwinding) 20 Until about half roll than needs to lower gradually

Vacuum table 5

Head height 14mm

Recommended Settings

Figure 6-39  

Figure 6-40  
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Before adding a job to the queue, you have the option of cropping it.
1. From the front-end window, choose the Add icon.

6.11 Cropping a Job

Figure 6-41  : Select a File
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2. Double-click the job's preview box at the lower left corner of the Select Job window. 

Figure 6-42  : Crop Preview Dialog Box

You can crop the job by:
• Entering the required values at the lower right corner of the dialog box, choose Apply and then OK.
• Drag the cross-hair cursor over the image, to define the area that has to be cropped, and choose OK.

The job's preview box shows the job before cropping, as well as the crop marks.
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3. Choose Select Job.

Figure 6-43  : Crop Preview Dialog
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The procedure for multi-roll printing is very similar to that of printing on a single roll. Make sure you have sufficient 
external core holders.

6.12.1 Configuring
1. From the front-end window, go to Preferences dialog box.
2. In the End Of Media box, check the appropriate end of media options and choose OK.

6.12.2 Preparing the Printer for Multi-Roll Printing
1. In the Automatic Media Position Measurement from the Media Settings dialog box, select the appropriate number of rolls to be 

printed. 

2. To measure the media choose the Measure Media button.

Figure 6-44  Measure Media Button

3. When the measurement is complete, choose OK.
4. Import the relevant file and specify the number of copies required.
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The file is 120 cm wide. If there is not enough room on current roll for the next copy (along the X-axis,) the copy is printed on the next roll.
 

Figure 6-45  
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When the Skip White feature is activated, any continuous white area (that is, area free of printing data) is skipped. When 
the carriage reaches a ‘white’ area, it returns to the home position and pauses. The media continues to pass through the 
printer at a faster rate and without being printed on. When the media reaches the specified position, it starts to print 
again. This saves print time and consequently reduces the total job time.

When the Skip White check box is selected in the Preferences dialog box, the printer skips ‘white’ areas. The carriage 
goes to home position, and the media advances continuously, until reaching the next printing area in the job. Then the 
printing continues normally.

The following figure shows the image that is to be printed, in this case, the Japanese flag with crop-marks. When the 
carriage reaches the area marked ‘skip’, the carriage returns to its home position and the media continues to pass 
through the printer. When the media reaches the area marked ‘print’, the carriage resumes printing.
   

6.13 Skip White Printing (Optional)

Figure 6-46  : Print with White Areas to Skip
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6.13.1 Enable Skip White Feature

From the Print Settings group box in the Preferences dialog box, check the Skip White option. The Open Media Press On 
Skip-white option is used when printing on a challenging media that is tension sensitive and tends to wrinkle. When this 
option is activated, the press shaft opens when the media advances to skip white and closes as the printing resumes.

Figure 6-47  : Skip White Settings
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The following procedure can be used for printer shutdown periods of up to 72 hours. For long-term shutdown (over 72 
hours) or for printer storage, contact your EFI service representative.

NOTE:  Unless there is an emergency, do not use the Emergency Stop Buttons or Cord to turn off the printer.

1. Purge and clean print heads.
2. Close FE software and shut off computer.
3. Switch off main power stitch.

6.14 Shutdown Procedure
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  7.0 Double-sided Printing 

Operations Guide
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Double-sided printing enables you to print jobs with accurate print registration between the front and back of the media.

There are two types of double-sided printing:
• Backlit –Print the same image on both sides of the media. (See Backlit Printing (Optional).)
• Blockout – Printing a different image on each side of the media. (See Blockout Printing.)

The double-sided settings are in the Double Side Print group in the Preferences dialog box. (See Preferences Dialog Box.) 

Both the Backlit and Blockout processes can be carried out in two ways:
• Head-to-head – Print Side A, then roll the media back, flip it, reload it, and print Side B. 
• Head-to-tail - Print Side A, cut the media at the end of the job, then take the printed media, load it onto the Printer, and print 

Side B.

7.0 Double-sided Printing (Optional)

Figure 7-1  



Double-sided Printing

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 144

 

• Backlit – Side A squares, side B cross, along the Y axis.

Figure 7-2  

Side A Side B A & B

• Blockout – Horizontal Blockout label, on side A only

Figure 7-3  

Label - Side A

7.1 Registration Print Marks
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7.1.1 Y Gap before Image

The distance between the first printed Backlit registration marks and the image, along the Y-axis. The value is usually set 
to 600 mm, so the initial correction is done before the image starts to print.

Figure 7-4  

Y Gap Before Image
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7.1.2 X Gap from Image

The distance between the printed backlit registration marks and the image along the X-axis. This value depends on the 
image and the media width. It is recommended to leave a 15 mm gap between the image and the marks.

Figure 7-5  

X Gap from Image
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Front Mark Colors/Back Mark Colors
You can select between C, M, Y and K for the front mark color and back mark color.

Print Cutting line – This line is printed at the end of side A, and marks where to cut 
the media, leaving sufficient margin for loading the media to the Printer to print Side 
B (2nd line), as shown in Figure 7-6.

Blockout Label to Image - Sets the distance of the Blockout label from the Image. 
The minimum value is 30 mm, there’s no need for a higher value.

Short Measure - Shortens the Measure Media function between copies in Blockout.

Figure 7-6  

2nd Line 

1st Line 
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This feature enables you to print the same image on both sides of the media, while maintaining accurate registration 
between both sides. The image on Side B can be printed in with either 100% or 50% density (if enables in the Print Mode).

Figure 7-7  

Side A Side B Registered Backlit 
Printing

To see the marks printed on Side A when printing Side B, use the LED illumination bars.

7.2 Backlit Printing (Optional)
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7.2.1 LED Illumination Bars

The LED illumination bars are installed on the edge of the print table, under the media. They illuminate the back side of 
the media so that the registration marks are visible to the camera. The illumination bars should be manually switched on 
before printing Side B. The switch is located on the front right side of the printer.
 

Figure 7-8  
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7.2.2 Backlit - Head-to-Head - Print Side A
1. To start the backlit print process, load suitable media onto the printer.
2. Perform Measure Media and prepare the printer to print.
3. Before starting to print Side A, cut two slits in the left and right edges of the media, at the edge of the print table.

Figure 7-9  

Print Table Edge Print Starting Point

Figure 7-10  

4. In the EFI FE, add the job to the queue. In the Job Settings dialog > 
Double Side group box, select the Backlit option, as shown in 
Figure 7-10.

5. Start printing Side A.

NOTE:  Make sure that the media is collected properly on the 
front shaft.

6. When you finish printing Side A, roll the media back, unload it, flip the media and load it to the printer.

NOTE:  Do not change Double-sided settings in Preferences after printing Side A. Do not change the Job settings, 
except for the Backside check box.
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7.2.3 Backlit - Head-to-Head - Print Side B

1. After loading the media, align the slits to the edge of the print table.

2. Perform Measure Media.

3. Turn the Backlit illumination ON.

Figure 7-11  

4. In the EFI FE, take the mjob from the Done pane to the Printing Queue. Double-
click the mjob to open the Job Settings.

5. In the Job Settings dialog’s Double Side group box, check the Backside check 
box, and click OK.

6. Start printing Side B.

Figure 7-12  

The printing starts with the Back side Marks and pausing for adjustments.

7. Click Yes. The carriage docks at the home position. You can open the printer’s 
cover and check the registration between the front and the back marks.

The Printer Status window opens. The goal is to align the marks of Side B to the 
center of the marks of Side A. 



Figure 7-13  
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8. In the Image Position spin boxes, set the required adjustment according to the 
print result.

9. Resume printing, constantly checking the registration. If required, you can adjust 
the image position during printing.

Examples:

 
Tilt Left – Insert a positive value in the Left spin box.
Tilt Right – Insert a positive value in the Right spin box.
Misregistration - Insert a positive value in the left-right spin box, and a negative value in 
the up-down spin box.

NOTE:   You can also open the Printer Status window by double clicking the 
Ink Level icon on the bottom right side of the screen.

Figure 7-14  

Tilt Left Tilt Right Misregistration Good 
Registration

Figure 7-15  
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7.2.4 Backlit - Head-to-Tail - Print Side A
1. Load suitable media onto the printer.

2. Perform Measure Media and prepare the printer to print.

Figure 7-16  

3. In the EFI FE, add the mjob to the Queue. In the Job Settings dialog’s Double Side 
group box, select the Backlit option.

4. Start printing Side A.

NOTE:  Make sure that the media is collected properly on the front shaft.

5. When you choose Print, the Skip Media prompt appears.

Figure 7-17  
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You must ensure that there is enough media on the core so that the media 
does not detach from it at the end of the Side B printing.  If you choose Yes 
on the prompt, the media advances by 50 cm before printing starts. If you 
choose No, printing starts immediately. 

The first line indicates the start of Side B print. As the media will be upside 
down when you print Side B, you will not be able to see this line. Therefore 
you should make two slits in the media, exactly on that line, one on the 
left and one on the right.

The second line indicates where to cut the media, so that you leave 
sufficient margin to load it on the Printer to print Side B. 

NOTE:  It is recommended to take an extra space (±1 meter) from the 
second line.

6. Cut the media to release it from the Printer.

NOTE:  Do not change Double side settings in Preferences after 
printing Side A. Do not change the Job settings, except for the 
Backside check box.

Figure 7-18   Print Side A

2nd Line 

1st Line 
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7.2.5 Backlit - Head-to-Tail - Print Side B
1. Load the media for printing Side B. Remove the air shaft with the printed media, and load it to the rear side of the 

printer without flipping or turning it.
 

2. Align the slits to the edge of the Print Table.

3. Perform Measure Media.

4. Turn the Backlit illumination ON.

5. In the EFI FE, take the mjob from the Done pane to the printing queue. Double-click the mjob to open the Job Settings.

6. In Job Setting window’s Double Side group, check Backside check box, and click OK.

7. Start printing Side B. Printing starts with Back side marks and pausing for adjustments.

8. Click Yes. The Carriage docks at home position. You can open the printer’s cover and check 
the registration between the front and the back marks.

9. The Printer Status window opens. The goal is to align the marks of Side B to the center of the marks of Side A. 

10. In the Image Position spin boxes, set the required adjustment according to the print result.

11. Resume printing, constantly checking the registration. If required, you can adjust the image position during printing.

Figure 7-19  



Double-sided Printing

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 156

The Blockout feature provides accurate double-sided printing on opaque media. In addition to the contents of the job, 
the front side of the media is printed with two horizontal stripes which, when printing the back side, are read by a sensor 
and the registration between both sides is calculated. Blockout sensor is located at center rear section of print table.

Short 
Measure

Figure 7-20  

Head to 
Head

Blockout 
Label

NOTE:  In order to facilitate the correct registration on the back side. It is very important to collect the media straight
and tightly onto the roll.

7.3.1 Blockout - Head-to-Head - Print Side A

1. From the Preferences dialog box, in the Double Side Print group, 
select the Head-to-Head option.

2. In the Blockout Label To Image field, enter the required distance 
between the stripes and the image, at a minimum of 30 mm.

3. EFI recommends that you check the Short Measure check box. 

Short Measure
In Blockout printing there is a Measure Media procedure that takes 
place before and during printing, between copies.

Taking these measurements ensures the correct printing registration 
between Side A and Side B.

In a regular measurement, the carriage moves along the print table, 
and measures both the first edge of the media (i.e., the media 
location) and the media width. It then returns to its home position, 
and the printing starts or continues.

Short Measure is designed to maintain efficiency. When the Short 
Measure option is activated, the carriage only takes the first edge 
measurement and returns to its home position, and the printing 
continues. This measurement is only taken between copies.

To activate this option, go to Double Side Print group in Preferences dialog, and check Short Measure check box.

7.3 Blockout Printing
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4. Load the media onto the printer.
5. Perform Measure Media.
6. Make slits on the left and right side of the media, at the front edge of the print table.

Figure 7-21  

Print Table Edge Print Starting Point

7.

Figure 7-22  

Open a job (Side A), and in the Job Settings dialog, select Blockout option.

NOTE:  Be sure the job is centered.

8. Start printing.

The media automatically advances and two black horizontal stripes are printed on it. The media is automatically measured again. 
The job starts printing. This procedure is carried out for each copy.

9. Collect the printed media on a media core, using the front limiters.
10. After printing, roll the media back onto its roll.
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7.3.2 Blockout - Head-to-Head - Print Side B
1. Flip the media and load it properly again.
2. Bring the two slits to the front edge of the print table. Make sure that both the slits are positioned at the edge of the print table. If 

the media is tilted, reload it.
3. Perform a Measure Media.

Figure 7-23  

4. Open the Side B job. In the Job Settings dialog box, choose 
Blockout and Back Side.

• Make sure that the job is centered.
• Make sure that the Side B file is the same size as side A, and you print 

the same number of copies.

5. Print the job.

The media automatically advances, until the sensor detects the stripes 
and the print starts at the correct position.

In both Head-to-Head and Head-to-Tail processes, if the blockout 
sensor does not recognize the two stripes, Figure 7-24 appears.

If this message appears, carry out a blockout sensor calibration. 
(See Blockout Sensor Calibration for details)

Figure 7-24  
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7.3.3

Figure 7-25  

Blockout - Head-to-Tail - Print Side A
1. Load and collect the media properly.

2. From the Preferences dialog box, in the Double Side Printing group, 
choose the Head To Tail radio button.

EFI recommends that you check the Short Measure check box. (See 
Short Measure.)

3. Open a job and in the Job Settings dialog, select the Double-side 
check box and then the Blockout option.

4. Print Side A.

Figure 7-26  

 

The skip media prompt displays.

5. Choose Yes, and the Media advances by 50 cm before the printing starts. 
Choose No, and the print starts immediately.

NOTE:  Make sure that there is at least 50 cm of collected media on the 
core. This is to prevent the media from detaching from the 
core at the end of Side B printing.
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At the end of the job, two consecutive horizontal lines are printed. The first line 
indicates the Start Point of the Side B printing. Cut a slit at both edges of the 
line. These slits help you find the Start Point, when loading the media to print 
Side B. The second line shows where to cut the media, so that when loaded to 
print the other side, there is enough media to reach the freefall pistons.

6. Cut the media at the second line.
7. Load the media for printing Side B. Remove the Air Shaft with the printed media, 

and load it to the rear side of the Printer without flipping or turning it.

Figure 7-27  

2nd Line 

1st Line 
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7.3.4 Blockout - Head-to-Tail - Print Side B
1. Load the printed media to the machine, and bring the slits to the front edge of the print table.

NOTE:  Make sure that the media is properly loaded. If you detect a tilt, reload the media.

2.

Figure 7-28  

Measure the media.
3. Open a job (Side B), and in the Job Settings dialog box, check Blockout option.
4. Make sure the job is centered.

• Make sure that the Side B printing starts with the last job printed on Side 
A, and ends with the first one.

• Make sure to print the same number of copies from each job.

5. Print Side B.

The media automatically advances, until the sensor detects the stripes and the 
print start sat the correct position.

The media advances until the sensor detects the stripes on Side A, and the job is printed at the required location. The media 
automatically advances, until the sensor detects the stripes and the print starts at the correct position.

In both Head-to-Head and Head-to-Tail processes, if the Blockout Sensor does not recognize the two stripes, Figure 7-29 appears.

If this happens you should carry out sensor calibration. (See Blockout Sensor Calibration.)

Figure 7-29  
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7.3.5 Blockout Sensor Calibration

There are two types of block-out sensor calibration: manual and automatic.

Figure 7-30  

Manual
1. Start printing a block-out job according to the standard procedure.

2. After printing the first side, reinstall the media for the second side 
according to the selected process (Head-tail or Head-head).

3. Align the media to the front edge of the printing print table 
according to the process.

4. Open the Blockout Sensor Calibration dialog box, select Manual 
and choose Start.

5. Advance the media by 50 mm. The first black stripe is above the 
sensor, and sensor beam is approximately at center of the stripe.

6. Choose End.

7. Rewind the media back by 50 mm until it is aligned again with the 
front edge of the print table and continue printing the second side.



Figure 7-31  
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Automatic
1. Start printing a block-out job in accordance with the standard procedure.

2. After printing the first side, reinstall the media for the second side according to 
the selected process (Head-tail or Head-head).

3. Align the media to the front edge of the print table according to the process.

4. Open the Blockout Sensor Calibration dialog, select Automatic 
and choose Calibrate.

5. Make sure that the media is aligned with the front edge of the print table and 
continue printing the second side.
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8.0 In-line Finishing (Optional)

Operations Guide
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The slitter is an in-line finishing device that cuts away any unwanted media (such as side margins) during the printing 
process. This feature is purely mechanical and is independent of any electrical or pneumatic processes. The blade cuts 
the media in the Y-axis, as it advances through the printer.

Figure 8-1  

The slitter includes a metal body, a blade retractor, a safety pin, and a fastening handle. The slitter is designed to be manually placed any-
where on the front beam, facing the   printer. It does not disturb the carriage movement and cannot damage the tension roller. The protru-
sion on the blade’s arm prevents the blade from damaging the tension roller. Raising the roller pushes the blade back to its docking position.

There are two types of slitters:
• Single Bladed 
• Double Bladed – Two blades, 8 mm apart.

8.0 In-line Finishing (Optional)

8.1 Media Slitters

Caution:  The slitters' blades are extremely sharp! Extreme care must be 
taken when handling them. You must keep the blades retracted 
when not in use!



In-line Finishing

Document ID: OMM-00165 Rev. C Pro 32r Operations Guide 166

8.1.1 Working with the Slitters

The printer software helps you place the slitters, by printing slitter marks before the job starts.

1. In the Preferences dialog box, set the relevant parameters for the slitter mark locations (in the space between the print table and 
the T roller) and the mark length.

Figure 8-2  
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2. Set the values in one of the following ways:

A. To 260-300 mm

B.

Figure 8-3  

Set Location of Slitter Mark Relative to Job. Place a check mark in the 

option “Add In-line Finishing by Default” and click . Slit Job to 
edge (0), Bleeding into the image (negative value), or Leaving 
Margins (positive value).

C.  For each job in the Job Settings dialog box, import the job to slit and 
enable the Slitter Mark feature in Job Settings. 

 
3. Start printing the job. 

4. After printing the slit marks, the printer pauses and the following message displays:

 
5. a. Yes: The Carriage moves to the Home Position. Place the Slitters.

b. No: Continue printing.

Figure 8-4  
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6. Open the cover, attach required number of slitters according to 
marks, and push handle towards printer to fasten them in place.

 
7. To activate the slitter blade, extend the blade. The blade should 

penetrate the media. 
 

8. Close the cover and continue printing.

9. To release the slitter at the end of the session, retract the blade and pull the handle.

8.1.2 Waste Media
Collect the waste media or allow it to fall freely at the front of the printer and collect only the net print.

Figure 8-5  

Slitter Mark

Slitter

Figure 8-6  
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